Chapter 2
Basic Object Construction and Dynamic Input

Learning Objectives

- Referencing the WCS
- Use the Startup dialog box
- Set up GRID & SNAP intervals
- Display AutoCAD's toolbars
- Set up and use OBJECT SNAPS
- Edit, using the TRIM command
- Use the POLYGON command
- Create TTR circles
- Create Tangent lines
AutoCAD Certified User Examination Objectives Coverage

This table shows the pages on which the objectives of the Certified User Examination are covered in Chapter 2.

Section 1: Introduction to AutoCAD
- Precision .................................................. 2-10
- UCS icon Origin ........................................ 2-10
- Status Bar .................................................. 2-10
- GRID Display ............................................. 2-10, 2-11
- Drawing LIMITS ........................................ 2-11
- Zoom Extent .............................................. 2-12

Section 2: Creating Basic Drawings
- Dynamic Input ........................................... 2-3
- Drawing Limits ........................................... 2-6
- Direct Distance option ................................ 2-6
- Startup dialog box, Show ............................. 2-7
- Dynamic Input Settings ............................... 2-7
- Start from Scratch .................................... 2-9
- World Space .............................................. 2-12
- World Coordinate System ........................... 2-12
- User Coordinate System ............................. 2-12
- Circle – Center, Radius ............................... 2-13
- Object Snap toolbar ................................... 2-14
- Endpoint, Snap to ..................................... 2-14
- TANGENT, Snap to .................................... 2-15
- TTR, circle ............................................... 2-17
- Polygon ................................................... 2-20
- Center, Snap to ........................................ 2-22

Section 3: Manipulating Objects
- Trim command .......................................... 2-19

Section 4: Drawing Organization and Inquiry Commands
- QuickCalc command .................................. 2-24
- Measure Distance command ....................... 2-24
Introduction

The main characteristic of any CAD system is its ability to create and modify 2D/3D geometric entities quickly and accurately. Most CAD systems provide a variety of object construction and editing tools to relieve the designer of the tedious drudgery of this task, so that the designer can concentrate more on design content. It is important to note that CAD systems can be used to replace traditional drafting with pencil and paper, but the CAD user must have a good understanding of the basic geometric construction techniques to fully utilize the capability of the CAD systems.

One of the major enhancements of AutoCAD 2006 was the introduction of the Dynamic Input feature. This addition, which is also available in AutoCAD 2015, greatly enhanced the AutoCAD Heads-up Design™ interface.

The use of the User Coordinate System (UCS) and the World Coordinate System (WCS) is further discussed in this chapter. In working CAD, one simple approach to creating designs in CAD systems is to create geometry by referencing the World Coordinate System. The general procedure of this approach is illustrated in this chapter.

In this chapter, we will examine the Dynamic Input options, the basic geometric construction and editing tools provided by AutoCAD 2015. We will first look at the Dynamic Input options, also tools such as UNITS, GRID, SNAP MODE intervals setup and the OSNAP option, followed by construction tools such as circles and polygons; we will also look at the basic Trim command.

Starting Up AutoCAD 2015

1. Start AutoCAD 2015 by selecting the Autodesk folder in the Start menu as shown. Once the program is loaded into the memory, click Start Drawing to start a new drawing.
Dynamic Input

In AutoCAD 2015, the **Dynamic Input** feature provides the user with **visual tooltips** and **entry options** right on the screen.

*Dynamic Input* provides a convenient command interface near the cursor to help the user focus in the graphics area. When *Dynamic Input* is ON, tooltips display information near the cursor that is dynamically updated as the cursor moves.

The tooltips also provide a place for user entry when a command is activated. The actions required to complete a command remain the same as those for the command line. Note that *Dynamic Input* is **not** designed to replace the command line. The main advantage of using the *Dynamic Input* options is to keep our attention near the cursor.

The *Dynamic Input* features simply enhance the five methods for specifying the locations of points as described in Chapter 1, page 1-18.

1. To switch on the **AutoCAD Dynamic Input option**, use the *Customization option* at the bottom right corner.

2. Switch **ON** the *Dynamic Input* option by clicking on the button in the *Status Bar* area as shown.
3. Click on the **Line** icon in the *Draw* toolbar. In the command prompt area, the message "_line Specify first point:" is displayed.

4. Move the cursor inside the Drawing Area and notice the displayed tooltip, which shows the coordinates of the cursor position.

5. Type **3** and notice the input is entered in the first entry box.

6. Hit the **TAB** key once to move the input focus to the second entry box.

7. Type **2** and notice the input is displayed in the second entry box.

8. Hit the **ENTER** key once to accept the inputs.

9. Move the cursor upward and toward the right side of the screen. Notice the tooltip is set to use polar coordinates by default.

10. Type **2** and notice the input is displayed in the entry box as shown.

11. Hit the **TAB** key once to move the input focus to the second entry box.

12. Type **30** and notice the input is displayed in the angle entry box.

13. Hit the **ENTER** key once to create the line that is 2 units long and at an angle of 30 degrees.
14. Move the cursor upward and toward the right side of the screen. Notice the tooltip is still set to using polar coordinates.

> To switch to using the relative Cartesian coordinates input method, use a comma as the specifier after entering the first number.

15. Type 2,3 and notice the input option is now set to using relative Cartesian coordinates as shown.

16. Hit the ENTER key once to accept the inputs.

17. Move the cursor toward the right side of the last position until the angle is near 180 degrees as shown.

18. Type 4 and notice the input is displayed on the screen.

19. Hit the ENTER key once to accept the input and note a horizontal line is created.

> In effect, we just created a line using the Direct Distance option.
20. In the Status Bar area, right-mouse-click on Dynamic Input and choose Settings.

The Settings dialog allows us to control what is displayed when Dynamic Input is on.

Note that the Dynamic Input feature has three components: Pointer Input, Dimensional Input, and Dynamic Prompts.

21. On your own, toggle ON/OFF the three options and create additional line-segments to see the different effects of the settings.

The RockerArm Design

Before continuing to the next page, on your own, make a rough freehand sketch showing the steps that can be used to create the design. Be aware that there are many different approaches to accomplishing the same task.
Activate the Startup Option

- In AutoCAD 2015, we can use the Startup dialog box to establish different types of drawing settings. The startup dialog box can be activated through the use of the STARTUP system variable.

The STARTUP system variable can be set to 0, 1, 2 or 3:
- 0: Starts a drawing without defined settings.
- 1: Displays the Create New Drawing dialog box.
- 2: Displays a New Tab with options, a custom dialog box can be used.
- 3: Displays a New Tab with options (default).

1. In the command prompt area, choose the Startup option from the list or enter the system variable name: STARTUP [ENTER]

2. Enter 1 as the new value for the Startup system variable.

3. To show the effect of the Startup option, exit AutoCAD by clicking on the Close icon as shown.

4. Restart AutoCAD by selecting the AutoCAD 2015 option through the Start menu.
5. The Startup dialog box appears on the screen with different options to assist in the creation of drawings. Move the cursor on top of the four icons and notice the different options available:
(1) Open a drawing
(2) Start from Scratch
(3) Use a Template
(4) Use a Setup Wizard

6. In the Startup dialog box, select the Start from Scratch option as shown in the figure.

7. Choose Metric to use the metric settings.

8. Click OK to accept the setting.

---

**Drawing Units Display Setup**

1. On your own, activate the display of the AutoCAD Menu Bar. (Refer to page 1-4 for the procedure.)

2. Click the Menu Bar area, select:
   [Format] → [Units]
2-10 AutoCAD 2015 Tutorial: 2D Fundamentals

**GRID and SNAP Intervals Setup**

3. Set the *Precision* to **no digits** after the decimal point.

4. Click **OK** to exit the *Drawing Units* dialog box.

5. On your own, adjust the option settings so that only the **Dynamic Input** option is turned **ON** in the *Status Bar* area.

6. Click **OK** to exit the *Drawing Units* dialog box.

---

AutoCAD 2015 Tutorial: 2D Fundamentals

**i. Drawing Units**

- **Type**:
  - **Decimal**
  - **Decimal Degrees**

- **Precision**:
  - **0**
  - **0**

**Sample Output**

- 2.2,0
- 3,45,0

**Lighting**

Units for specifying the Intensity of lighting:

- **International**

1. In the *Status Bar* area, right-mouse-click on *Snap Mode* and choose **[Snap Settings]**.

2. In the *Drafting Settings* dialog box, select the **Snap and Grid** tab if it is not the page on top.

3. Change **Grid Spacing** and **Snap Spacing** to **10** for both X and Y directions.

4. Switch **ON** the *Display dotted grid in 2D model Space* option as shown.

5. Switch **ON** the **Grid On** and **Snap On** options as shown.

6. Click **OK** to exit the *Drawing Units* dialog box.
**Drawing Area Setup**

Next, we will set up the **Drawing Limits**. Setting the Drawing Limits controls the extents of the display of the grid. It also serves as a visual reference that marks the working area. Note that this setting can also be adjusted through the use of the command prompt area.

1. Click inside the **command prompt area**.

2. Inside the command prompt area, enter **Limits** and press the [Enter] key.

3. In the command prompt area, near the bottom of the AutoCAD drawing screen, the message “Reset Model Space Limits: Specify lower left corner or [On/Off] <0,0>:” is displayed. Enter **-200,-150** through the **Dynamic Input** entry boxes.

4. In the command prompt area, the message “Specify upper right corner <420,297>:” is displayed. Enter **200,150** as the new upper right coordinates as shown.

5. On your own, use the **Menu Bar** and confirm the [View] → [Display] → [UCS Icon] → [Origin] option is switched **ON** as shown. (The little checked icon next to the option indicates it is switched **ON**.)
6. On your own, use the **Zoom Extents** command, under the **View** pull-down menu, to reset the display.

- Notice the **UCS Icon**, which is aligned to the origin, is displayed at the center of the Drawing Area.

---

**Referencing the World Coordinate System**

Design modeling software is becoming more powerful and user friendly, yet the system still does only what the user tells it to do. When using a geometric modeler, we therefore need to have a good understanding of what the inherent limitations are. We should also have a good understanding of what we want to do and what to expect, as the results are based on what is available.

In most geometric modelers, objects are located and defined in what is usually called **world space** or **global space**. Although a number of different coordinate systems can be used to create and manipulate objects in a 3D modeling system, the objects are typically defined and stored using the **world space**. The **world space** is usually a **3D Cartesian coordinate system** that the user cannot change or manipulate.

In most engineering designs, models can be very complex, and it would be tedious and confusing if only one coordinate system were available in CAD systems. Practical CAD systems provide the user with definable **Local Coordinate Systems (LCS)** or **User Coordinate Systems (UCS)**, which are measured relative to the world coordinate system. Once a local coordinate system is defined, we can then create geometry in terms of this more convenient system. For most CAD systems, the default construction coordinate system is initially aligned to the world coordinate system.

In AutoCAD, the default **User Coordinate System (UCS)** is initially aligned to the XY plane of the **World Coordinate System (WCS)**. One simple approach to creating designs in CAD systems is to create geometry by referencing the **World Coordinate System**. The general procedure of this approach is illustrated in the following sections.
Creating Circles

1. Click on and switch back to the **Home** tab in the **Ribbon** tabs and panels area.

2. Select the **Circle – Center, Radius** command icon in the **Draw** toolbar. In the command prompt area, the message “*circle Specify center point for the circle or [3P/2P/Ttr (tan tan radius)].*” is displayed.

3. Select the **origin** of the world coordinate system as the center point location.

4. In the command prompt area, the message “*Specify radius of circle or [Diameter].*” is displayed. AutoCAD expects us to identify the radius of the circle. Set the radius to **50** by observing the tooltips as shown.

5. Hit the [**SPACE BAR**] once to repeat the circle command.

6. On your own, select **70,40** as the absolute coordinate values of the center point coordinates of the second circle.

7. Set the value of the radius to **25**.

8. On your own, repeat the above procedure and create another circle (radius **25**) at absolute coordinates of **-50,-60** as shown in the figure.
Object Snap Toolbar

1. Move the cursor to the Menu Bar area and choose [Tools] → [Toolbars] → [AutoCAD].

- AutoCAD provides 50+ predefined toolbars for access to frequently used commands, settings, and modes. A checkmark (next to the item) in the list identifies the toolbars that are currently displayed on the screen.

2. Select Object Snap, with the left-mouse-button, to display the Object Snap toolbar on the screen.

- Object Snap is an extremely powerful construction tool available on most CAD systems. During an entity's creation operations, we can snap the cursor to points on objects such as endpoints, midpoints, centers, and intersections. For example, we can turn on Object Snap and quickly draw a line to the center of a circle, the midpoint of a line segment, or the intersection of two lines.

3. Move the cursor over the icons in the Object Snap toolbar and read the description of each icon.

4. We will next turn OFF the GRID SNAP option by toggling off the SNAP Mode button in the Status Bar area.

5. On your own, reset the option buttons in the Status Bar area, so that only the GRID DISPLAY option is switched ON.
Using the LINE Command

1. Select the **Line** command icon in the *Draw* toolbar. In the command prompt area, near the bottom of the AutoCAD drawing screen, the message "*line Specify first point:" is displayed.

2. Pick **Snap to Tangent** in the *Object Snap* toolbar. In the command prompt area, the message "*_tan to" is displayed. AutoCAD now expects us to select a circle or an arc on the screen.

   ❖ The **Snap to Tangent** option allows us to snap to the point on a circle or arc that, when connected to the last point, forms a line tangent to that object.

3. Pick a location that is near the top left side of the smaller circle on the right; note the tangent symbol is displayed as shown.

   ❖ Note that the note "Deferred Tangent" indicates that AutoCAD will calculate the tangent location when the other endpoint of the line is defined.

4. Pick **Snap to Tangent** in the *Object Snap* toolbar. In the command prompt area, the message "*_tan to" is displayed. AutoCAD now expects us to select a circle or an arc on the screen.
5. Pick a location that is near the top left side of the center circle; note the tangent symbol is displayed as shown.

6. Inside the Drawing Area, right-mouse-click to activate the option menu and select Enter with the left-mouse-button to end the Line command.

A line tangent to both circles is constructed as shown in the figure.

7. On your own, repeat the above steps and create the other tangent line between the center circle and the circle on the left. Your drawing should appear as the figure.
Creating TTR Circles

1. Select the **Circle** command icon in the *Draw* toolbar. In the command prompt area, the message “Specify center point for circle or [3P/2P/Ttr (tan tan radius)]:” is displayed.

2. Inside the Drawing Area, right-mouse-click to activate the option menu and select the **Ttr (tan tan radius)** option. This option allows us to create a circle that is tangent to two objects.

3. Pick a location near the **bottom of the smaller circle** on the right. We will create a circle that is tangent to this circle and the center circle.

4. Pick the **center circle** by selecting a location that is near the right side of the circle. AutoCAD interprets the locations we selected as being near the tangency.
5. In the command prompt area, the message “Specify radius of circle” is displayed. Enter 50 as the radius of the circle.

Specify radius of circle: 50 [ENTER]

6. On your own, repeat the above steps and create the other TTR circle (radius 40). Your drawing should appear as the figure below.
Using the *TRIM* Command

- The *Trim* command shortens an object so that it ends precisely at a selected boundary.

1. Select the **Trim** command icon in the *Modify* toolbar, click on the down-triangle to display additional icons as shown. In the command prompt area, the message "Select boundary edges... Select objects:" is displayed.

- First, we will select the objects that define the boundary edges to which we want to trim the object.

2. Pick the *tangent line* connecting the center circle and the top right circle.

3. Pick the *lower right circle*. The two selected entities are highlighted as shown in the figure.

4. Inside the *Drawing Area*, **right-mouse-click** once to proceed with the Trim command.

5. The message "Select object to trim or shift-select object to extend or [Project/Edge/Undo]:" is displayed in the command prompt area. Pick the *left* section of the upper right circle and note the selected portion is trimmed as shown.

- In AutoCAD, the *Trim* command requires first selection of objects that define the cutting edges at which an object is to stop. Valid cutting edge objects include most 2D geometry such as lines, arcs, circles, ellipses, polylines, splines, and text. For 3D objects, a 2D projection method is used where objects are projected onto the XY plane of the current user coordinate system (UCS).
6. Select the upper right side of the center circle to remove the selected portion.

7. Inside the Drawing Area, right-mouse-click to activate the option menu and select Enter to end the Trim command.

8. Hit the [SPACE BAR] once to repeat the Trim command.

9. Select the two arcs that were trimmed as the two cutting edges and trim the lower section of the TTR circle as shown.

10. On your own, trim the other geometry so that the drawing appears as shown.

11. Inside the Drawing Area, right-mouse-click to activate the option menu and select Enter with the left-mouse-button to end the Trim command.
Using the **POLYGON** Command

1. Select the **Polygon** command icon in the **Draw** toolbar. Click on the triangle icon next to the rectangle icon to display the additional icon list.

2. Enter 6 to create a six-sided hexagon.
   
   
   polygon Enter number of sides <4>: 6 [ENTER]

3. The message “Specify center of polygon or [Edge]:” is displayed. Since the center of the large circle is aligned to the origin of the WCS, the center of the polygon can be positioned using several methods. Set the center point to the origin by entering the absolute coordinates. Specify center of polygon or [Edge]: 0,0 [ENTER]

4. In the command prompt area, the message “Enter an option [Inscribed in circle/ Circumscribed about circle] <I>:” is displayed. Click **Circumscribed** to select the **Circumscribed about circle** option.

5. In the command prompt area, the message **Specify radius of circle:**” is displayed. Enter 30 as the radius. Specify radius of circle: 30 [ENTER]

- Note that the polygon option [Inscribed in circle/Circumscribed about circle] allows us to create either **flat to flat** or **corner to corner** distance.
6. Inside the Drawing Area, **right-mouse-click** to activate the option menu and select **Repeat Polygon**. In the command prompt area, the message "\_polygon Enter number of sides <6>:" is displayed.

7. Enter **4** to create a four-sided polygon.

   \_polygon Enter number of sides <6>: 4 [ENTER]

8. In the command prompt area, the message "Specify center of polygon or [Edge]:" is displayed. Let's use the **Object Snap** options to locate its center location. Pick **Snap to Center** in the **Object Snap** toolbar as shown.

9. Move the cursor on top of the arc on the right and notice the center point is automatically highlighted. Select the arc to accept the highlighted location.

10. Inside the Drawing Area, **right-mouse-click** to activate the option menu and select **Circumscribed about circle**.

11. Switch **ON** the **GRID SNAP** option in the **Status Bar** as shown.

12. Create a square by selecting one of the adjacent grid points next to the center point as shown. Note that the orientation of the polygon can also be adjusted as the cursor is moved to other locations.
Creating a Concentric Circle

1. Select the **Circle** command icon in the *Draw* toolbar. In the command prompt area, the message “Specify center point for circle or [3P/2P/Ttr (tan tan radius)]:” is displayed.

2. Let’s use the **Object Snap** options to assure the center location is aligned properly. Pick **Snap to Center** in the *Object Snap* toolbar as shown.

3. Move the cursor on top of the lower arc on the left and notice the center point is automatically highlighted. Select the arc to accept the highlighted location.

4. In the command prompt area, the message “Specify radius of circle <25>” is displayed. Enter **10** to complete the Circle command.

   - **Specify radius of circle <25>: 10 [ENTER]**
Using the QuickCalc Calculator to Measure Distance and Angle

- AutoCAD also provides several tools that will allow us to measure distance, area, perimeter, and even mass properties. With the use of the Object Snap options, getting measurements of the completed design can be done very quickly.

1. Inside the Drawing Area, right-mouse-click once to bring up the option menu.
2. Select QuickCalc in the option menu as shown.

- Note that the QuickCalc option brings up the AutoCAD calculator, which can be used to perform a full range of mathematical, scientific, and geometric calculations. We can also use QuickCalc to create and use variables, as well as to convert units of measurement.

3. Click the Measure Distance icon, which is located on the top section of the QuickCalc calculator pad.

4. Pick Snap to Endpoint in the Object Snap toolbar.

5. Select the top tangent line, near the lower endpoint, as shown.
6. Pick **Snap to Endpoint** in the *Object Snap* toolbar.

7. Select the tangent line, near the upper endpoint, as shown.

- The length of the line is displayed in the *QuickCalc* calculator as shown.

8. Click the **Clear** icon to remove the number displayed.

9. On your own, repeat the above steps and measure the center to center distance of the lower region of the design as shown. (Hint: use the **Snap to Center** option.)
10. Click the **Measure Angle** icon, which is located on the top section of the *QuickCalc* calculator pad.

Note that this option allows us to measure the angle between the horizontal axis and the line formed by the two selected points. A positive angle indicates a counterclockwise direction.

11. Pick **Snap to Endpoint** in the *Object Snap* toolbar.

12. Select the tangent line, near the lower endpoint, as shown.

13. Pick **Snap to Endpoint** in the *Object Snap* toolbar.
14. Select the tangent line, near the upper endpoint, as shown.

> The measured angle is displayed in the calculator pad as shown.

15. On your own, experiment with the available **Get Coordinates** options.

> Note also that the QuickCalc calculator can remain active while you are using other AutoCAD commands.
Saving the CAD File

1. In the Application Menu, select:

   [Application] → [Save]

   ◇ Note the command can also be activated with quick-key combination of [Ctrl]+[S].

2. In the Save Drawing As dialog box, select the folder in which you want to store the CAD file and enter RockerArm in the File name box.

3. Pick Save in the Save Drawing As dialog box to accept the selections and save the file.

Exit AutoCAD

- To exit AutoCAD 2015, select Exit AutoCAD from the Application Menu or type QUIT at the command prompt.
Review Questions: (Time: 20 minutes)

1. Describe the procedure to activate the AutoCAD **Startup** option.

2. List and describe three options in the AutoCAD **Object Snap** toolbar.

3. Which AutoCAD command can we use to remove a portion of an existing entity?

4. Describe the difference between the *circumscribed* and *inscribed* options when using the AutoCAD **Polygon** command.

5. Create the following triangle and fill in the blanks: Length = ____, Angle = ____.
   (Dimensions are in inches.)

   ![Triangle Diagram]

6. Create the following drawing; line $AB$ is tangent to both circles. Fill in the blanks:
   Length = ____ , Angle = ____.
   (Dimensions are in inches.)

   ![Circle Diagram]
Exercises:
(Unless otherwise specified, dimensions are in inches.) (Time: 90 minutes.)

1. Adjustable Support

![Adjustable Support Diagram]

2. V-Slide Plate (The design has two sets of parallel lines with implied tangency.)

![V-Slide Plate Diagram]
3. **Swivel Base** (Dimensions are in Millimeters.)

![Swivel Base Diagram](attachment:image)

4. **Sensor Mount**

![Sensor Mount Diagram](attachment:image)
5. **Flat Hook** (Dimensions are in Millimeters. Thickness: 25 mm.)